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Steve Jobs’ Greatest Achievements
Click here to read entire article online.

With Steve Jobs' passing, we have lost one of the greatest technological innovators of our time.

Jobs wasn't just a savvy businessman, he was a visionary who made it his mission to humanize personal 
computing, rewriting the rules of user experience design, hardware design and software design. His actions 
reverberated across industry lines: He shook up the music business, dragged the wireless carriers into the boxing 
ring, changed the way software and hardware are sold and forever altered the language of computer interfaces. 
Along the way, he built Apple up into one of the most valuable corporations in the world.

Quite a run. He will be missed.

Mac Tip of the Week #353
Excerpted from Mac OS X Lion: Peachpit Learning Series by Robin Williams and John Tollett

Merge Selected Duplicate Cards in Your Address Book

Command-click to select the cards you want to merge. From the Card menu, choose Merge 
Selected Cards.

Address Book creates a single card, merges the unique information from each card, and uses 
the name and picture of the card that appeared first in the list.

http://www.vom.com/svcg/
http://www.vom.com/svcg/
http://www.wired.com/gadgetlab/2011/10/steve-jobs-greatest-achievements/?pid=2448&viewall=true
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http://e.pearson.info/pub/cc?_ri_=X0Gzc2X%3DUQpglLjHJlTQ4rQGyy4QiosJQsfXQzc1uFGQGQaQ8zaWVXtpKX%3DSRDSTSTC&_ei_=8312wfG0Xb9X%3DUB8GCWS7qGW8BqWGADqD69TqD6RRCAC9zgCYYVGf6beX6990G11X%3DsrHHgLklHKxuLQJhu.
http://e.pearson.info/pub/cc?_ri_=X0Gzc2X%3DUQpglLjHJlTQ4rQGyy4QiosJQsfXQzc1uFGQGQaQ8zaWVXtpKX%3DSRDSTSTC&_ei_=8312wfG0Xb9X%3DUB8GCWS7qGW8BqWGADqD69TqD6RRCAC9zgCYYVGf6beX6990G11X%3DsrHHgLklHKxuLQJhu.
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1. Adobe Creative Suite 5 Resource Center
Whether you're a new user who needs to learn Adobe 
software from scratch, an early adopter who wants to 
get up to speed on the new features, or an experienced 
pro looking for inspiration, Peachpit has just the book 
or video for you.

2. Adobe Launches Creative Suite 5.5
Adobe Creative Suite 5.5 enables designers to create 
and deliver content across multiple media formats, 
including print, web, video, digital publications and 
mobile devices such as smartphones and tablets.

3. Adobe Photoshop CS4: Learn by Video 
iPhone Application 
With two hours of high-quality video tutorials, quizzes 
to test progress, and lesson files to use with the video, 
users can quickly and conveniently gain the skills they 
need at the click of a button.

4. Adobe Photoshop Lightroom 3 Resource 
Center
Ready to learn Lightroom 3? Well you've hit the 
proverbial jackpot. We've got what you need to know 
all in one cool place.

5. Boost your productivity with your new 
iPad!
3 iPad training videos for just $19.99

6. Bring Your Photos and Videos to Life with 
Adobe Photoshop Elements 10 and Adobe 
Premiere Elements 10
Introducing Adobe Photoshop Elements 10 and Adobe 
Premiere Elements 10

7. Buy any 3 Adobe Classroom in a Book titles 
and save 40% the off list price
For a limited time, buy 3 or more Classroom in a Book 

titles and you will receive an EXCLUSIVE 40% 
discount and FREE shipping (US only). Simply enter 
coupon code CIB40 at step 3 of checkout to redeem.

8. Color Management without the Jargon 
Video
Conrad Chavez teaches the basics of color 
management, including how to set up your monitors 
and create consistent color in your workflow.

9. Create the Web - Save up to 40% on Web 
Design and Development Titles
Join the movement to create a better Web! Save 35% 
off one, or 40% when you buy two or more Web 
Development and /or Web Design titles. It's Peachpit's 
Create the Web Sale!

10. CSS with CWS Video by Charles Wyke-
Smith
In this video, Charles Wyke-Smith provides a solid 
introduction in how to use CSS effectively, and shows 
you the step-by-step process of styling a page.

11. Designing the Moment Video by Robert 
Hoekman
Learn the design elements that will help your users 
understand the purpose of your Web application, what 
they can gain from it, what to expect, whether or not 
they can trust it, and how long it might take to get up to 
speed.

12. Designing Web Accessibility for a Beautiful 
Web Video
Andy Clarke shows how using a modern workflow 
eliminates common accessibility problems.

13. Designing with CSS for a Beautiful Web 
Video
Author and CSS guru Andy Clarke teaches some 

Very cool deals. 
Check them out!☜
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fundamental concepts about designing using CSS and 
working with a range of browser tools to open up the 
creative opportunities.

14. Fall into Photography with Peachpit - Save 
35-40%!
Fall into Photography with Peachpit! Save 35% off 
one, or 40% off of two or more books or videos with 
our Fall Photography Sale! Enter code FALLPHOTO 
during checkout.

15. Final Cut Studio Resource Center
Whether you're a new user learning Final Cut Studio 
from scratch or a seasoned video pro taking your skills 
to the next level, Peachpit has just the book for you. 
Get started with our free sample tutorials!

16.FREE Web 2.0 Marketing eBook on social 
media, SEO, SEM, Facebook, blogging, 
YouTube
Download a free 10-chapter FREE Web 2.0 Marketing 
eBook on social media, SEO, SEM, Facebook, 
blogging, and YouTube.

17.Get up and running in no time with Video 
QuickStarts!
Each Video QuickStart offers more than an hour of 
short, task-based videos and rich graphics to 
demonstrate key concepts.

18.Handcrafted CSS: Bulletproof Essentials
Dan Cederholm provides an essential checklist to make 
your next project a flexible, adaptable, and well-crafted 
design.

19. Inspired CSS: Styling for a Beautiful Web 
Video by Andy Clarke
Andy Clarke shows you how to take your design to the 
next level using typography, microformats, advanced 
CSS selectors, layout techniques employing floats, 
positioning, and margins, and CSS3.

20. Introducing Final Cut Pro X
Whether you're a new user who needs to learn Final 
Cut Pro X from scratch, an early adopter who wants to 
get up to speed on the new features, or an experienced 
pro looking for inspiration, Peachpit has just the book 
or video for you!

21. Introducing Peachpit and Learn By Video 
iPad Apps!

Learn the latest techniques in photography, Web 
design, Adobe software and more with these new 
Peachpit and Learn by Video apps for your iPad.

22.Learn by Video: Revolutionize the way you 
learn Adobe software
Learn by Video from video2brain and Adobe Press is a 
complete video training program that will 
revolutionize the way you learn Adobe software.

23.Learn Your Way
Looking for an eBook, video, or app to brush up or 
expand your photography and design skills? However 
you like to soak up new skills, Peachpit helps you learn 
your way!

24.Mac OS X Server v10.6 Snow Leopard--
Faster, More Reliable, Easier to Use
Whether you're new to the OS or an experienced 
Macintosh user ready to hone your troubleshooting 
skills, pick up a Peachpit book today to get the most 
out of the powerful features in Snow Leopard.

25.Make the Most of Your New Camera: Turn 
Your Snapshots into Great Shots - 2011
From Snapshots to Great Shots is an inspirational 
digital photography book series that provides a perfect 
blend of instruction and reference for exact camera 
models.

26.Marty Neumeier's INNOVATION 
WORKSHOP Video
Marty Neumeier presents concepts from his three 
bestselling “whiteboard” books—THE BRAND GAP, 
ZAG, and THE DESIGNFUL COMPANY—to give 
you the tools you’ll need to thrive in the new economy.

27.Mastering Web Content: Behavior with 
Ajax Video by Greg Rewis
CSS expert Greg Rewis teaches Web designers and 
developers how to create Ajax-style behaviors that will 
work for all users, using Spry and jQuery.

28.Mastering Web Content: Structure and 
Presentation with XHTML and CSS Video 
by Stephanie Sullivan
CSS expert Stephanie Sullivan delivers a roadmap for 
approaching web design projects, teaching you how to 
save precious development time and still create 
accessible, search-engine friendly content.
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29.OS X Lion
OS X Lion is here and we have exactly the resource 
you need to master the basics and all the stunning new 
capabilities of Apple's most advanced operating 
system ever.

30.PayPal Press
PayPal Press is a collaborative effort between 
Peachpit and PayPal, publishing books and eBooks 
which help everyone make the most of PayPal's 
products and services.

31.Peachpit Authors are All a-Twitter
You’ve probably already heard about Twitter. You 
may even be Twittering around yourself. But did you 
know that Peachpit and New Riders authors are 
Tweeting, too?

32.Peachpit Online Video: Web Design, 
Photoshop, Business Innovation, iPhoto, 
and more
Anytime and anywhere you have a high-speed 
Internet connection, you can access Peachpit's online 
video training. It's true learning on demand, when and 
where you want it.

33.Peachpit Photo Club
Join us on the third Tuesday of every month, from 8 
to 9 p.m. EST (5-6 p.m. PST), for a webcast featuring 
your favorite digital photographers

34.Photo Recipes Live by Scott Kelby
Scott Kelby, author of the best-selling The Digital 
Photography Book, brings to life his "Photo Recipes" 
chapter. In this two-hour video, Scott shows you 
exactly how it’s all done, from scratch, without 
holding anything back.

35.Photoshop Studio with Bert Monroy: 
Lessons in Digital Painting Video by Bert 
Monroy
Digital artist Bert Monroy invites you into his 
personal studio in Berkeley, California, to share the 
inspirations and secrets behind his stunning art using 
Adobe Photoshop.

36.Presentation Zen Video by Garr Reynolds
Garr Reynolds expands on his ideas from his popular 
book and blog and challenges you to go beyond the 
conventional slide presentation style and think more 
creatively to achieve simpler, more effective 
presentations.

37.SEO and Beyond: A Holistic Approach to 
Findability Video by Aarron Walter
Learn the basic concepts behind SEO and findability, 
as well as practical web standards by watching noted 
Web design expert, author, and consultant Aarron 
Walter take a real-world project from paper to pixel.

38.Stay Connected with Peachpit on Twitter, 
Facebook, YouTube, and Flickr
Tune in for the latest news, podcasts, videos, articles, 
exclusive offers and more!

39.Tantek Celik's HTML5 Now: A Step-by-
Step Video Tutorial for Getting Started 
Today
This video and companion booklet provide 
instruction, examples, and explanations to get started 
using HTML5 immediately, whether you're starting a 
new project or transitioning existing HTML and 
XHTML pages to HTML5.

40.The Best Camera Is The One That's With 
You: iPhone Photography by Chase Jarvis
The pictures in this book, all taken with Chase’s 
iPhone, make up a visual notebook from the past year 
of his life. The book is full of visually rich iPhone 
photos and peppered with inspiring anecdotes.

41.The Portrait Photography Course
Save 35% off the list price of The Portrait 
Photography Course

42.
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New ReleasesNew Releases
Digital PhotographyDigital Photography

Wildlife Photography: From 
Snapshots to Great Shots
By Laurie Excell
List Price: $24.99
 

Digital Video EditingDigital Video Editing
Adobe Premiere Elements 
10 Classroom in a Book
By Adobe Creative Team
List Price: $54.99
 

Final Cut Pro X: Visual 
QuickStart Guide
By Lisa Brenneis and 
Michael Wohl
List Price: $39.99
 

Image EditingImage Editing
Adobe Photoshop Elements 
10 Classroom in a Book
By Adobe Creative Team
List Price: $44.99
 

Photoshop Down & Dirty 
Tricks for Designers
By Corey Barker
List Price: $49.99
 

Photoshop Elements 10 for 
Windows and Mac OS X: 
Visual QuickStart Guide
By Jeff Carlson
List Price: $39.99
 

Photoshop Elements: From 
Snapshots to Great Shots
By Jeff Revell
List Price: $24.99
 

Web Design / Web ProgrammingWeb Design / Web Programming
HTML5 Multimedia: 
Develop and Design
By Ian Devlin
List Price: $39.99

WordPress: Visual 
QuickStart Guide
By Matt Beck and Jessica 
Neuman Beck
List Price: $29.99
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Mac Tip of the Week #344

Excerpted from Mac OS X Lion Pocket Guide by 
Jeff Carlson

Encrypt Your Data with 
FileVault

To encrypt the contents of your 
hard disk, do the following:

1.Open the Security & Privacy 
preference pane and click the 
FileVault button.

2. Click the Turn On FileVault button. (You 
may need to first click the padlock button in 
the lower-left corner of the window to be 
able to make changes to the settings.)

3. On the dialog that appears, write down the 
recovery key and store it somewhere safe. If 
you forget your password, this code can 
grant access to the system. Click the 
Continue button.

4. Choose whether to store the recovery key 
with Apple or not. Doing so requires that 
you choose three questions and provide 
answers; if you lose your recovery key, 
answering the questions exactly can get it 
back. Click Continue to proceed.

5. In the next dialog, click the Restart button to 
restart the Mac and begin the encryption 
process. While Mac OS X is crunching the 
data, you can still use your computer; return 
to the Security & Privacy preference pane to 
view the progress.

Mac Tip of the Week #343

Excerpted from Mac OS X Lion Pocket Guide by 
Jeff Carlson

What To Try If Disk Utility Fails

Sometimes directory corruption is too severe for 
Mac OS X's built-in Disk Utility application to 
repair. In that case, turn to Alsoft's DiskWarrior, 
which succeeds where many other disk utilities fail.

Mac Tip of the Week #345

Excerpted from The Little Mac Book, Lion Edition 
by Robin Williams

Color-Code Your Contextual Labels

When you Control-click a folder, a blank spot in a 
window, a disk icon, a document, or an application, 
you get a contextual menu. Did you notice that each 
contextual menu has an option called Label with 
colored dots? You can choose one of those colors to 
make the selected icon that color. This can be a 
handy organizing tool—color all your love letters 
red, all tax files mustard, all research papers blue, 
etc. Later, you can search for files with a particular 
label color.

We’ll demo this at the next meeting!

Click here 
to read 
more about 
Mac OS X 
Lion by 
Robin 
Williams

Click here 
to read 
more 
about OS 
X Lion by 
Maria 
Langer

Click here 
to read 
more about 
the Mac OS 
X Lion 
Project 
Book by 
Scott 
McNulty
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Mac Tip of the Week #342

Excerpted from Mac OS X Lion: Peachpit Learning 
Series by Robin Williams and John Tollett

Visual Learner? Check Out Apple's 
Online Tutorials

Apple provides hundreds of video tutorials about 
Mac basics and Mac applications (such as iPhoto, 
iMovie, iWeb, GarageBand, iWork, and MobileMe) 
on its website. Visit www.apple.com/startpage and 
look for Video Tutorials, or just use Safari to do a 
Google search for "Mac video tutorials." You'll find 
more video as well as text tutorials at 
www.apple.com/findouthow/mac that include 
additional topics, from "Get Started with Mac" to 
"Using iChat."

Mac Tip of the Week #341

Excerpted from Mac OS X Lion: Peachpit Learning 
Series by Robin Williams and John Tollett

Peek Inside a File with Quick Look

Quick Look lets you quickly preview almost any 
kind of file without actually opening it. Simply 
select a file and then press the Spacebar to preview 
it in Quick Look. To close Quick Look, hit the 
Spacebar again, press Command-Y, click the Close 
Quick Look (x) button in the upper-left corner of 
the Quick Look window, or choose File > Close 
Quick Look.

Learn iPhoto: Mac 
Video Training

1 By Paul Garay, Michael Kaye
2 Published Aug 20, 2010 by Peachpit 

Press.
Taking the picture is only the beginning! 
Learn how to import, edit, and share your 
precious memories using iPhoto 08. Sit back 
and watch us demonstrate how to get the most 
from your digital photos and create your own 
color prints, slide shows, professional 
greeting cards, personalized calendars and 
even publish your own hard-cover coffee-
table photo book. Most importantly, we will 
show you how to safeguard your priceless 
images using iPhoto's built-in backup and 
archive software.

Click here to read more.
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Mac Tip of the Week #352
Excerpted from Mac OS X Lion: Visual QuickStart Guide by 
Maria Langer

Burn Folder: Keep or Delete?

When you're finished using a burn folder, you can delete it or 
keep it:

• If you delete the burn folder, none of the original files 
are lost, because the burn folder contains only aliases 
for original files.

• If you keep a burn folder, you can create new discs 
from it again and again in the future. Because the burn 
folder contains aliases rather than original files, the 
latest versions of the files will always be burned onto 
the disc.

Mac Tip of the Week #351
Excerpted from The Little Mac Book, Lion Edition by Robin 
Williams

Force an Application to Quit

To give you a menu choice to force an application to quit, 
Option-press (don't click) that application's icon in the Dock.

Mac Tip of the Week #350
Excerpted from The Mac OS X Lion Project Book: Stuff You 
Can Do with Your Mac by Scott McNulty

Print Without Paper

What do you do when you need to print a web receipt for your 
records but don't want to waste a piece of paper? Hit Print 
anyway! For as long as there's been an OS X, full support for 
PDFs has been baked into the operating system. A PDF, as you 
may know, is an electronic version of a document that renders 
the fonts and graphics just as they would appear on a printed 
page. Think of a PDF as being much like an electronic printout. 
With Lion, you can "print" a PDF in much the same way that 
you send a document to a printer. Here's how to print the 
paperless way:

1. Conduct the online business for which you want a 
receipt. For example, if you've just booked a hotel 
room, you may want to save the confirmation web 

page, which includes your confirmation number and 
how much you paid.

2. At the web page you want to save, choose File > Print 
or press Command-P to open the default Print sheet.

3. Click the PDF drop-down menu in the bottom-left 
corner of the sheet to display the PDF options.

4. Choose Save PDF to Web Receipts Folder from the 
PDF menu. Lion creates a PDF of the current web 
page and saves it in a folder called Web Receipts 
inside your Documents folder. (If the Web Receipts 
folder doesn't already exist, Lion creates it.)

5. Do what you want with your "printed" document: 
email it to someone, keep on your computer for later 
reference, post it online, or even (if you want to defeat 
your purpose) print it on paper. If you want to make 
that document "portable," choose Add PDF to iTunes, 
which creates a PDF of the document and adds it to 
the Books section of your iTunes Library. Then you 
can sync that PDF to your iPad, iPhone, or iPod touch 
for reading on the go.

Mac Tip of the Week #349
Excerpted from Mac OS X Lion: Visual QuickStart Guide by 
Maria Langer

Backup Basics

Everyone has his or her own strategy for creating and 
maintaining backups. Here are some things to consider when 
formulating yours:

Back up often. The more often you back up your files, the more 
likely you are to have an up-to-date copy of a file if you need it. 
It follows that the more often a file changes, the more often it 
should be backed up.
Maintain multiple backups. If the most recent backup copy of a 
file is also damaged, an older backup copy might not be. If you 
back up important data files to CD or DVD disc, keep as many 
backups as practical. Be sure to label the discs with the date so 
you know which one is most recent.

Keep important backups off-site. If your computer is destroyed 
by flood or fire and your backups were stored with it, you've 
lost everything. By keeping a backup of your important files in 
a different location, you add an additional level of protection.
Consider backing up to "the cloud." Cloud computing refers to 
the use of computing resources accessible via the Internet. If 
you're a MobileMe user, you have access to "cloud" storage 
space through the use of iDisk. Dropbox (www.dropbox.com) 
is an example of a free service that provides secure storage for 
files on a remote server.

Automate backups whenever possible. You're far more likely to 
stick to a backup strategy if it's mostly or entirely automated. 
Time Machine (page 125) makes this very easy to do, but there 
are other third-party backup solutions, including SuperDuper 
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(www.shirt-pocket.com/SuperDuper/) and Carbon Copy Cloner 
(www.bombich.com).

Consider using MobileMe to sync important data. If you're a 
MobileMe user, you can use its sync feature to automatically 
back up your calendar, contacts, mail accounts, and other data. 
Although this is intended primarily for syncing this data 
between two or more computers or devices, it can also be used 
as a simple, automated backup.

Mac Tip of the Week #348
Excerpted from Mac OS X Lion Pocket Guide by Jeff Carlson

Repairing Permissions

Every file on your hard disk is tagged with permissions that 
limit what actions can be performed, such as whether a file can 
be edited, or which user accounts can act on it. Click Repair 
Disk Permissions in the First Aid pane of Disk Utility. 
Repairing permissions was once thought to be a general fix for 
any weird behavior, but in fact permissions now apply only to 
files installed by Apple's installers. For more information, see 
the Apple support article "Troubleshooting Permissions Issues 
in Mac OS X."

Mac Tip of the Week #347
Excerpted from Mac OS X Lion: Peachpit Learning Series by 
Robin Williams and John Tollett

Socialize Musically with Ping

Ping is a social network for music that's built right into iTunes. 
Follow your favorite artists and friends, see what music they're 
buying, and read their comments about albums and songs. You 
can also allow others to follow your own song choices and read 
comments that you choose to post on Ping. To get started, click 
the Ping option in the Sidebar; then click the Turn on Ping 
button. Follow the instructions onscreen to create a new Ping 
account; then start following the artists, celebrities, and friends 
who interest you.
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What AppleCare covers

Apple sells AppleCare contracts for a variety of hardware 
items: Macs, Apple displays, iPods, Apple TVs, iPhones, and 
iPads. All of these devices come with a limited one-year 
warranty, and this includes 90 days of telephone support to help 
you get set up and resolve any problems you may have. Apple 
also offers AppleCare+ for the iPhone, which includes repair or 
replacement for accidental damage, under certain conditions, 
and with a service fee.

But beyond that, you're on your own. If you need repairs after a 
year, you'll have to pay for them out of pocket; and if you have 
problems you can't resolve by visiting Apple's support forums, 
then you'll either have to find a friend who can help you, or pay 
for phone support.

AppleCare extends both of these types of support—hardware 
repairs and telephone support—to a total of three years for 
computers and displays, and two years for other devices. You 
can buy an AppleCare contract when you buy your new Mac, or 
any time in the first year, though if you wait, you won't get that 
extended phone support after 90 days and before you buy the 
AppleCare contract.

Also, if you buy a Mac and other items (a display, any AirPort 
devices, or certain other accessories), the contract for a Mac 
will cover all of these. For devices like an iPhone, for example, 
you get a total of two years of coverage, and must purchase the 

contract within 30 days of buying your phone. (See Apple's 
AppleCare web pages for precise conditions and prices.)
When it's worthwhile

I've been living in a rural area for 12 years; I'm far from any 
Apple service center, and I've bought AppleCare contracts for 
all my Macs since I moved here. However, I don't buy them for 
iPods, iPads or other devices; I've never had any problems with 
them, and I can work if they go on the blink. However, if my 
Mac has trouble, then I need repairs quickly so I don't lose too 
much working time.

If you live in an area like me, AppleCare is a worthwhile 
investment. If you're near an AppleStore, however, and you use 
your Mac at home, spending an extra $150 or more may not 
seem worthwhile. You can always drop into the Apple Store and 
get a diagnosis or repair (if it's still the first year).

If you use your Mac for work, I wouldn't even think twice: I'd 
get AppleCare right away. If you consider how much it would 
cost you to not be able to work, the small investment you make 
in an extended warranty is insurance that will be useful in case 
of problems. Of course, if something is seriously wrong with 
your Mac, and on-site service is out of the question, you'll still 
need another Mac to work; Apple doesn't loan computers when 
they take yours in for repair.

Depending on the device and the type of repair, you may be 
asked to drop it off at a nearby Apple repair center (if there is 
one near you); you may asked to mail it to Apple, in which case 
they'll send you a box to pack it in; or they may offer on-site 
repairs. (There's no rule as to when they do on-site support; in 
my experience, when they are sure what part needs to be 
replaced they will come to your home or office; when they have 
doubts, and need time to test the Mac, they'll ask you to ship it.) 
I've had technicians drive to my home, about two and a half 
hours from their repair center, to replace parts in Macs: once for 
a video card in an old CRT iMac; another time for a CD drive in 
a similar model; and once for the front connectors on a Mac 
Pro. The time I saved for each of those repairs was well worth 
the cost of the AppleCare contract.

If you have a laptop, and carry it around a lot, AppleCare is 
certainly a good investment. Laptops get bumped around a lot, 

Macworld guide to AppleCare
by Kirk McElhearn, Macworld.com
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and are more likely to have problems with, say, hard drives than desktops. Also, if your battery goes bad, Apple may replace it under 
your AppleCare warranty.

Note that when you buy an AppleCare contract, it is valid worldwide. So if you travel a lot, and have a problem with a laptop, or if 
you have a child who's going abroad for a year of school, having that warranty will ensure that any problems encountered will be 
covered.

One final reason to buy AppleCare with Macs: if you keep your Macs for less than three years, and want to sell them used, the 
AppleCare contract is transferrable. (You can also have Apple refund you a pro-rata portion of the contract if you prefer.) I've found 
that being able to sell a used Mac with several months of guarantee is a big plus; people are more likely to buy a used computer if they 
know they have some protection.

I now automatically buy AppleCare when I get a new Mac. I know plenty of people who never buy AppleCare contracts. Sometimes I 
have problems with my Macs that necessitate repairs or extended telephone support, and over the years, I've certainly felt that it was 
worth spending this extra money.

[Senior contributor Kirk McElhearn writes about more than just Macs on his blog Kirkville. Twitter: @mcelhearn Kirk is the author 
of Take Control of Scrivener 2.]

Six unexpected uses for the arrow keys
Navigate and activate menus, and more, with the often-overlooked arrows
by Sharon Zardetto, Macworld.com 

What could possibly be 
“unexpected” when it 
comes to those four 
humble directional keys? 
Perhaps it’s that, totally 
unadorned (that is, 
without a modifier such 
as Command or 
Control), they can do 
more than just move an 

insertion point around in text or select something in a list.

1. Select Finder items in icon view

When you’re in a Finder window looking at files using the 
icon view (View -> As Icons), pressing Tab selects the next 
alphabetic item no matter where its icon may be. But what if 
you want the item next to the currently selected one (or above 
or below it)? You don’t need your mouse or trackpad for this 
basic task. Use an arrow key to move to the item—even if it’s 
in a different row because the window’s sorted into groups 
with the Arrange By command.

2. Expand folders in the Finder

If you want to display a selected folder’s contents when 
you’re in a Finder list view window (View -> As List), don’t 
bother clicking on the expansion arrow. Instead, just press the 
Right arrow to expand a selected folder; press Left arrow to 
collapse it. (Adding Option when you expand a folder 
expands all its subfolders, too.)

This folder-expansion trick works in lists in Open and Save 
dialog boxes, too.

3. Scroll windows in Preview or Safari

In Apple’s Preview or Safari, you can the scrollbar to move up 
and down through the window. Or keep your hands on the 
keyboard and press the Up or Down arrow key to scroll a little 
bit at a time. Usually you’ll move the equivalent of one or two 
lines of text, although your mileage will vary based on the 
zoom level you’re using.

Bonus Tip To scroll down in bigger chunks, press the 
spacebar; press Shift-spacebar to scroll up.
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4. Move in and between menus

If you’ve clicked to open a menu, perhaps you’ve noticed that 
the arrow keys let you move through its commands. But you 
can also open the menu itself, and move to others, using the 
arrow keys.

The key to this trick is turning on the initial controls in the 
Keyboard Shortcuts pane of Keyboard preferences. Click 
Keyboard & Text Input on the left, and in the list at the right, 
check the boxes for Move Focus To The Menu Bar and Move 
Focus To The Status Menus.

Trigger these commands using their default shortcuts (Control-
F2 for the Menu bar and Control-F8 for the Status Menu—
those little icons on the right side of the menu bar). When you 
do, the first menu, or first status menu icon, is highlighted. Use 
the Left or Right arrow key to move to the menu you want. 
Press Down arrow to open a selected menu and then use the Up 
and Down arrows to move through the command. Press Return 
or the spacebar to trigger a command or, if you reach a 
submenu’s title, press Right arrow to pop it open.

(If you’re wondering why the arrow keys don’t seem to work 
with many items in the status menu, you’re not alone. My 

testing revealed this trick to generally apply only to items 
supplied by the OS. On my Mac, Dropbox, Twitterific, and 
QuicKeys icons are ignored in the selection cycle.)

5. Play a different tune in iTunes

When you’re listening to your music in iTunes, the Up and 
Down arrows select the previous or next item in your playlist, 
but don’t affect what’s playing. Use the Left or Right arrow to 
play the previous or next track—relative to what’s currently 
playing, not to what’s selected. (There’s no need to press 
Command along with the arrow keys, despite what’s noted in 
the Controls menu.)

6. Control Safari’s autofill

When you start to fill out a website form—a single letter in one 
field is often enough—Safari will show a pop-up with one or 
more suggestions as to where it might grab the information for 
the form. Save yourself the effort of a click or tap: Press the 
Down arrow when you see the pop-up to select what 
information you want used, and then press Return.

Start to fill out a web form and Safari suggests a source of information for the blanks (here, it’s an Address Book 
entry). Press the Down arrow to select the information in the pop-up and then press Return to fill the form.

SVCG Meeting 12/10 at 9 a.m. at Maria’s. 
For more info, contact Kathy at aanestad@vom.com
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Refurbished Mac buying guide by Joel Mathis, Macworld.com

Maybe you’re a college student. Maybe you’re one 
of America’s vast numbers of un- and under-
employed workers. Maybe you’re simply frugal. 
Whatever the case, the situation facing you is this: 
You’re on a budget, you need a new computer, but 
even with limited cash you’d rather not buy an 
inexpensive Windows-based PC—you’re an Apple 
fan and don’t want to switch. What to do?

Easy. Buy a refurbished Mac.

The Apple Online Store has a section where you can 
buy refurbished Macs, as well as refurbished iPads, 
iPods, and other Apple products. (The refurbs are 
listed under the Special Deals section of the left 
column of the online store.) Apple’s line of 
refurbished Macs runs the gamut from laptop 
computers to Mac minis to iMacs with giant 27-inch 
monitors. Some of the machines are pre-owned, 
while others were returned to the company because 
of technical defects. But all of them share two 
characteristics in common: They’ve been buffed, 
restored, and repackaged to meet Apple’s exacting 
standards. And they’re cheaper—sometimes a lot 
cheaper—than buying new.

Here are some answers to frequently asked 
questions about buying a refurbished Mac.

What is a refurbished Mac?

The category includes both pre-owned Macs and 
those returned for defects, although Apple says that 
only “some units” have been returned for technical 
issues. Before re-sale, Apple cleans the machine, 
replaces any defective or sub-standard parts, re-
installs software that originally shipped with the 
unit, tests the Mac for quality-control issues, then 
repackages it with fresh cables and a user’s manual. 
The company even stamps the machine with a new 
serial number.

Apple says all refurbished Macs meet the company’s 
Finished Goods testing procedures—which means 
that the machine you buy should be up to the same 
technical snuff as the exact same unit purchased 
brand-new.

What is the selection like?

The inventory is ever-shifting; as of the afternoon of 
Black Friday, it included both MacBook Pros and 
MacBook Airs, Mac Pros, iMac units of varying 
sizes, as well as several models of Mac mini. The 
selection skewed slightly older—with a number of 
units dating from 2010, and just a few from 2009; 
none were older than that. There were also a number 
of units dating from February and May of 2011, 
including current models of MacBook Pro and iMac.
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Free fonts for holiday greetings
When choosing fonts for a holiday project, you don’t need to stick to the overused snow-capped letters and 
frilly scripts. Whether for an invitation, an advertisement, a greeting card, or a holiday letter, there are several 
ways to add just the right amount of holiday flavor. Simply add a wintry dingbat, or use an English or Celtic-
looking font—I found several free fonts at FontSquirrel.com and 1001Fonts.com, and even in the font 
collection included on my Mac.

[http://www.macworld.com/article/163825/2011/12/free_fonts_for_holiday_greetings.html
%23lsrc.nl_mwweek_h_crawl]

Yellow-Magician Tangerine Dancing Script Tension Type Leander 

Kells Gothic-Ultra Nymphette Schluss Vignetten Floralia

Faux-Snow

FONT Example Example Example Example

Yellow-Magician ABCDE FGHIJK LMNOP QRSTU
Tangerine ABCDE FGHIJ KLM NOPQ
Dancing Script ABCDE FGHIJK LMNOP QRST U
Tension Type Leander

ABCDE FGHIJ KLMN OPQR
Kells ABCDE fGHIJK LMNOP qRSTU
Gothic-Ultra ABCDEFG HIJKLMNO PQRSTUV WXYZ1234
Nymphette

qw12 3579 zxc bnt
Schluss Vignetten

ed f g h
Floralia

ABCDE FGHIJ KLMNO PQRST
Faux-Snow

B d r i
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Printopia 2.1.5 By Dan Frakes, Macworld.com 

[I downloaded, 
installed and tested 
this program a 
couple days ago 
and it worked right 
off the bat, no 
hassles or 
confusing 
directions to 
follow — it just 
worked! - Ed.]

The AirPrint feature of iOS 4.2 promised to let you print, 
wirelessly, from your iOS device to any printer shared by your 
Mac. Unfortunately, AirPrint ended up working with only a 
few specific, AirPrint-enabled printers. One of the most 
popular recent Mac Gems, especially around the Macworld 
offices, is Printopia, a utility that delivers on Apple’s 
unfulfilled promise—and does much more.

I originally reviewed Printopia a year ago. As I explained then, 
Printopia takes over where AirPrint leaves off, letting your Mac 
share all or any configured printers, no matter how they’re 
connected to your Mac, with iOS devices on your local 
wireless network. In any iOS app that supports printing, you 
just tap the Print button, choose one of those printers, and 
print! And Printopia works with Mac OS X 10.7 (Lion), 10.6 
(Snow Leopard), and even 10.5 (Leopard)—and even with 
PowerPC Macs—making AirPrint available to anyone with a 
recent Mac. (Your iOS devices must be running iOS 4.2 or 
later.)

But Printopia had a number of other tricks up it virtual sleeve 
that made the utility useful even if you never actually needed to 
print. A special Send to Mac printer let you save—by printing
—a PDF copy of a document, or a JPEG or PNG version of an 
image, to a Printopia folder in your Mac’s Documents folder. 
And a Send To Dropbox On Mac printer let you save a 
document to your Mac’s Dropbox () folder, where the file is 
instantly synced to all your other Dropbox-enabled devices. 
These features were great for, say, saving receipts from online 
purchases made on your iPad or iPhone, and for transferring 
iOS screenshots to your Macs.

Since that review, Ecamm Network has released several 
significant updates to Printopia, including version 2.0 in April 
and version 2.1.5 earlier this week. Those updates have 
included a number of new features that have made Printopia 
even more useful. For example, you can now create an 
unlimited number of Save To Mac and Save To Dropbox 
virtual printers, each of them saving documents to a different 
folder on your Mac or inside your Dropbox folder, respectively. 
You choose which of those folders to save to by simply 
choosing a different virtual printer when printing.

But my favorite new feature is that you can set up Mac 
applications as virtual printers and then “print” to them. Doing 
so sends a copy of the document to your Mac and immediately 
opens the document in the chosen application. So, for example, 
you can send an iPad screenshot to your favorite Mac image 
editor, such as Acorn or Photoshop; the screenshot opens in 
that program, ready for editing. Or you can send a PDF directly 
from your iPhone to PDFpen on your Mac for annotation, or to 
Evernote for filing. (In fact, if Evernote is installed on your 
Mac, Printopia automatically creates an Evernote virtual printer 
for you.)

Similarly, you can configure any PDF workflow—those 
options under the PDF pop-up menu in Mac printing dialogs—
as a virtual printer, letting you process documents you print 
from your iOS device. To use the screenshot example again, 
you could set up a PDF workflow that opens an image in 

Click here for the article.
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Preview, resizes it to a particular size, and then saves it, as a 
PNG file, in your Website Images folder.

(Note that not every Mac program supports multi-page 
documents. For example, if you send a four-page document to 
an image editor, the program will likely display only the first 
page of the document.)

Also new since my original review is password security for 
each printer, real or virtual, so even if someone has access to 
your Wi-Fi network, they can’t print to your printer(s), or save 
files to your Mac(s), without the appropriate password(s). 
Similarly, you can now configure default settings for every 
printer. For real printers, this includes most of the settings—
paper size, paper handling, layout, output quality—you’d see in 
a Mac OS X printing dialog. For virtual printers, you can 
change the name of the printer and, for save-to virtual printers, 
the save location and whether saved files are opened 
automatically.

Another nifty new feature is support for AirPrint printing from 
Lion. In other words, all the options available to iOS devices on 
your local network are also available to any Macs running Mac 
OS X 10.7 or later. Using the Print & Scan pane of System 
Preferences (or by choosing the printer in the Printer pop-up 
menu in any OS X printing dialog), you can set up any 
Printopia-provided printer or virtual printer as a standard OS X 
printer. So you get the same save-a-Web-receipt-to-my-iMac 
and open-a-screenshot-on-my-iMac features on your MacBook 
as you get on your iPhone.

This feature has a couple side benefits, as well. First, as long as 
your other Macs are running Lion, you can disable OS X’s 
Printer Sharing feature and just use Printopia—you don’t need 
to use Printer Sharing and Printopia to share your printers with 
both Macs and iOS devices. Second, if you’ve got a printer that 

doesn’t have Lion drivers, you can connect the printer to a Mac 
running Printopia under, say, Leopard and then print to that 
printer from any Mac running OS X 10.7, instantly adding Lion 
support.

Ecamm has also fixed a number of minor bugs, such as one that 
reduced the quality of printed photos in certain circumstances, 
and added some useful tweaks. For example, Printopia can 
automatically fit your document to a each printer’s printable 
area, and when sending a photo to your Mac, the date and time 
the photo was originally taken are used both in the resulting 
file’s name and to set the date and time of the file itself. 
Printopia also now supports more printers, it supports duplex 
printing with particular printer models, and it works better with 
the OS X firewall.

As with the original version, Printopia’s biggest limitation is 
that it requires that iOS devices—and, now, Macs running Lion
—be on the same 
network with a computer 
that’s on and awake. But 
until the Ecamm folks 
can work technological 
magic, that limitation will 
remain, just as it does for 
OS X’s own Printer 
Sharing feature.

Printopia was already one 
of our favorite bits of 
software, and with the 
improvements the 
developer has added over 
the past year, it’s even 
more of a must-have.

F a A

http://www.vom.com/svcg/
http://www.vom.com/svcg/


HTTP://WWW.VOM.COM/SVCG/
     

SONOMA VALLEY COMPUTER GROUP 
 FALL 2011
 PAGE 19

12 Things You Didn’t Know Facebook Could Do
By PAUL BOUTIN NY Times

The designers and engineers 
who build Facebook are 
anything but complacent about 
their success. They face a 
constant threat from the career-
centric LinkedIn, specialized 
upstarts like Instagram’s mobile 
photo network and now 
Google’s fast-growing Google+, 
an attempt to improve on 

Facebook’s core design that 
has picked up tens of 
millions of users in its first 
few weeks.

So Facebook has been adding features to make the reigning 
social network more useful and convenient.

As the number of features grows, though, so does a 
corresponding problem: Most of Facebook’s 750 million users 
don’t know these features exist. Some don’t know how to find 
them, some don’t go hunting for them in Facebook’s ever-
growing interface of controls and many don’t even think of 
them in the first place. A few minutes of exploration can 
uncover functions that make Facebook not just an addiction but 
a pleasure to use.

EDIT LINK NAMES AND DESCRIPTIONS If you want to 
post a link to your Facebook page but don’t like the title or 
description that Facebook automatically pulls from the linked 
page, you can change it. Before you click the Share button, 
click on the title or description in your pending post. They will 
change into editing boxes, like those to rename a file on your 
computer desktop. When you’re done editing, press Enter to 
save your changes.

TAG FRIENDS IN UPDATES AND COMMENTS If you 
type the name of a Facebook friend while editing a status 
update or a comment, Facebook will automatically create a link 
to the friend’s page. In fact, it will pop up a list of possible 
completions for names like “John.” Once you’ve entered a 
name, you can backspace over it to erase the last name for 
informality’s sake, or click in the middle to edit the first, 

turning “Kenneth Smith” into “Kenneth” or “Smith.” Sorry, you 
can only shorten names — you can’t edit “Kenneth Smith” into 
“Snuggles.”

POST A PLAYABLE MP3 If you paste a link that ends in 
“.mp3” into a status update, Facebook will create a player in the 
middle of the update that lets other users play the music file 
without having to click through to its host site.

MAKE A PHOTO YOUR PROFILE PICTURE Any photo 
on Facebook that has been tagged with your name includes an 
extra blue link at the lower-left corner of its page labeled Make 
Profile Picture. Click that, and Facebook pops up an editing 
page in which you can crop the photo to be just right for your 
profile.

CREATE A POLL Hiding in plain sight above the box to enter 
status updates is a Question button. Posting a question looks 
just like posting an update, except that it takes the first three 
answers from your friends and turns them into a poll to keep the 
discussion focused. You can also set up the poll with your own 
answers, or add more to those Facebook creates.

COLLABORATE ON A DOCUMENT Within a Group page, 
click on Docs at the top of the page and then the Create a Doc 
button on the right-hand side to create a text-only document 
that everyone in the group can edit. When you save the 
document, it will be posted to the group’s feed, just like a status 
update, with an Edit button in the upper-right corner. To see 
previous revisions, click Recent Changes.

INVITE NON-FACEBOOKERS TO AN EVENT When you 
are creating an event on Facebook, the Select Guests menu 
shows your existing friends, but it also lets you enter the e-mail 
addresses of people who do not have Facebook accounts. Type 
one or more e-mail address, separated by commas, into the 
Invite by E-mail Address box. Your invitees will receive a 
message with a link to your event page that, unfortunately, 
prompts them to sign up for Facebook before they can look at 
it.

GET THE TICKER OUT OF YOUR WAY Facebook 
recently added a constantly scrolling window on the right side 

Minh Uong/The New York Times
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of the screen that shows your friends’ updates as they come in. 
Fun for some, agitating for others. You can’t turn it off entirely, 
but you can make the moving ticker as small as possible. Using 
your cursor, grab the bar that separates the Ticker from your 
Facebook Chat window. Drag it upward until the Ticker is as 
small as possible — the size of two status updates. That will 
reduce the level of unwanted distraction it causes while you’re 
trying to read the rest of the page, while still letting you see 
new updates.

ADD A CALENDAR TO YOUR PAGE If you’re a business 
owner, a team coach or a performer who wants to keep 
everyone on Facebook apprised of your coming events, simply 
creating separate Facebook events for each one can be 
ineffective. These can get lost in the stream of events, making it 
hard for people to check for, say, your next game. As an 
alternative, use the Social Calendar app, which was not 
developed by Facebook. Go to facebook.com/SocialCalendar 
and click the Add to My Page link in the lower left corner. That 
will pop up a menu of pages you manage. Click Add to Page 
next to one or more pages, then click Close. Those pages will 
now include a Calendar link in their upper left corner, just 
below Wall, Info and Photos. Social Calendar is pretty smart — 
it will autocomplete the names of events you’ve already 
created, and if you type in an Address field, it will add a map 
link to the location on the calendar. But for maximum 
attendance, you should still post status updates announcing an 
event.

TRACK YOUR PAGE’S SUCCESS On any page you own, 
whether it is for your business or your clog-dancing club, click 
View Insights in the upper right corner. Facebook will display 

charts of user information and page interactions. Beyond the 
number of Likes and comments, it will plot a graph of page 
views and user feedback, plus a breakdown of which Web 
domains are sending traffic to your page, and the demographics 
of your visitors. If you want to do your own number-crunching, 
you can export the data into an Excel-compatible file.

KEEP A BIRTHDAY PARTY A SECRET Do you want to let 
everyone except one or two people know what you’re up to? 
Edit a status update as usual, but before you post, click the lock 
icon below the editing box. That will pop up a menu with 
options for specifying who can see your update. By default, it’s 
set to Everyone. Choose Customize instead, and in the dialog 
box that pops up, enter one or more names in the box near the 
bottom that says Hide This From. There’s another button to 
make this your default setting for future updates, so you needn’t 
worry about accidental oversharing.

BLOCK ANNOYING COMMENTERS Do you have a friend 
who constantly posts inappropriate comments on your updates 
but whom you can’t bring yourself to unfriend? In the 
uppermost right corner of Facebook, click Account and choose 
Privacy Settings. That will take you to a page labeled Choose 
Your Privacy Settings. Near the bottom is a section labeled 
Sharing on Facebook. Hiding at the bottom of that section is a 
link labeled Customize Settings. Scroll down to Things Others 
Share. There’s a setting for “Permission to comment on your 
posts.” It works just like the filter for sharing status updates: 
click Customize, and enter names of people to keep Facebook 
from presenting them with comment features when they look at 
your posts. Maybe they’ll get the hint.

Q E R

http://www.vom.com/svcg/
http://www.vom.com/svcg/
http://facebook.com/SocialCalendar
http://facebook.com/SocialCalendar


HTTP://WWW.VOM.COM/SVCG/
     

SONOMA VALLEY COMPUTER GROUP 
 FALL 2011
 PAGE 21

http://www.sellyourmac.com/

Want to upgrade and sell your old Mac, iPhone, iPad, 
etc.? Well now you can at SellYourMac.com.

SellYourMac will purchase your used Apple equipment 
through a quick and convenient transaction. We strive to 
help families, students and young adults upgrade their 
Apple desktop computer or laptop by offering 
competitive prices for their used Apple product, 
including Mac Pro, iMac, Mac Mini, MacBook, 
MacBook Pro, MacBook Air, Powerbook G4, iBook, 
iPhone or iPod.

Since 2006, our company has served over 7000 
customers — and we're proud to have delivered the 
highest level of customer service possible. We provide 
free Live Chat and phone support for all purchases and 
take pride in following up with each customer after the 
sale has been made.

Free shipping is included in all purchases and we accept 
all major credit cards and PayPal payments. Looking for 
a custom configuration? Feel free to email us the specs 
and we can find one for you. Our eBay store features 
Apple hardware and other products. Check it out for 
yourself at http://stores.ebay.com/iSelliMac.

Cold Weather Care By Matt Klein

During the colder 
months, it’s important 
keep in mind that cold 
objects entering a 
warm, moist 
environment (like your 
home or workplace) will become damp with 
condensation. As liquid exposure of any type can 
void your warranty and result in costly repair, and 
as Apple now installs liquid exposure indicators 
inside each of its products, it’s vital that you keep 
your electronic gear safe.

If at all possible, do not keep your notebook, 
iPod, iPhone or other electronic gear in the car 
overnight in the cold. We’re beginning to see a 
few victims of condensation come through the 
shop, and it’s easy to avoid. If you find yourself 
with a moisture-covered device, the first thing to 
do is turn it off and remove the battery. iPod and 
iPhone users can only shut down and wait, as the 
batteries in these devices are not removable.

Legendary data recovery firm (and Small Dog 
data recovery partner) Drive Savers notes that 
this exposure to hard drives is particularly 
serious: “Cold weather can wreak havoc on 
temperature-sensitive hard drives used in 
computers, game consoles, MP3 players and 
video recorders. Condensation buildup on the 
drive platters and frozen components can lead to 
drive failure and data loss.”
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Two new Take Control ebooks about iOS 5
Make the most of iOS with two new Take Control ebooks

With iOS 5 and iCloud, Apple significantly expanded all 
that you can do on the iPad, iPhone, and iPod touch, but 
those new features require us end users to learn new skills 
and habits. To help you optimize your iOS 5 experience, 
we have two new ebooks for you today. One is a big, broad 
ebook about iOS 5 on the iPad, and the other is tightly 
focused on how to devise and manage an effective mobile 
email strategy for any device running iOS 5. 

* "Take Control of Your iPad" - You can 
read the entire ebook straight through to 
qualify for your iPad expert secret decoder 
ring, or you can dip in as needed to get help 
with setup, syncing, apps, and more. You'll 
benefit from the many hours that Tonya 
Engst has spent setting up and syncing her 
iPads as she teaches you to configure your 

original iPad or iPad 2 correctly, both through the new 
Setup Assistant and with key options that require extra 
effort. You'll pick up important skills that make gesturing, 
typing, and navigating more enjoyable and effective. You'll 
also find tips for setting up and getting more out of many 
of Apple's apps, plus real-world advice on buying and 
managing third-party apps.

Among much else, you'll find answers to these common 
questions: 

* What is Location Services, and is it okay if I turn it on?

* Should I back up to iCloud or to iTunes?

* How do I set up notifications and control the sounds they 
make?

* What are smart techniques for organizing my Home 
screen?

* How do I copy a new ebook into iBooks?

* How do I sync with more than one Google Calendar?

* How do I set up a Wi-Fi iTunes sync?

* What should I know before (and after) I shop for a new 
app?

This 170-page ebook is available now to answer all sorts of 
iPad questions for a mere $10.50 after the 30% MUG 
discount.

http://tid.bl.it/your-ipad-mug-discount

* "Take Control of Mail on the iPad, 
iPhone, and iPod touch, Third 
Edition" - Join tech writer extraordinaire 
Joe Kissell in this thoughtful and 
thorough explanation of how to set up 
the optimal email system on your iOS 
device. You'll find practical, real-world 
recommendations about the best ways to 
use the Mail app, and you'll get advice 

and directions for how to set up your accounts, receive 
email, read and send email, and file messages. You'll also 
learn to solve connection problems and work around 
feature limitations. 

Joe covers the basics and beyond, including answers to 
these questions:

* What's new in iOS 5 Mail?

* How do I set up my email accounts? 

* How do I set up mailboxes for effective navigation and 
filing? 

* How do I handle attachments? 

* How does Mail integrate with other apps, like Calendar 
and Contacts? 

* What are the best ways to find messages in the Mail app? 

* What's different about Exchange ActiveSync accounts? 

* How do I integrate Gmail with Mail? 

This 108-page ebook can help turn your iOS device into a 
lean, mean email machine for only  $7 after the 30% MUG 
discount.

http://tid.bl.it/ipad-mail-mug-discount
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SVCG MEMBERSHIP APPLICATION/RENEWAL FORMSVCG MEMBERSHIP APPLICATION/RENEWAL FORMSVCG MEMBERSHIP APPLICATION/RENEWAL FORM

New Applicant______

Renewal __________

PLATFORM:

Mac ______  Windows _________

Name: _____________________________________________________________

Address: ___________________________________________________________

City/State: __________________________________________________________

ZIP: ____________________________

Home Phone: _____________________

E-Mail Address: ____________________

Name: _____________________________________________________________

Address: ___________________________________________________________

City/State: __________________________________________________________

ZIP: ____________________________

Home Phone: _____________________

E-Mail Address: ____________________

Name: _____________________________________________________________

Address: ___________________________________________________________

City/State: __________________________________________________________

ZIP: ____________________________

Home Phone: _____________________

E-Mail Address: ____________________

Email your info to:

Kathy Aanestad

aanestad@vom.com

What are your favorite programs?

Special Interests?

USER LEVEL:

Novice _____    Intermediate _____

Advanced ____  Expert ______

How did you hear about the Club?

Class ______    Club member _______   Newspaper _______  Newsletter _________

How did you hear about the Club?

Class ______    Club member _______   Newspaper _______  Newsletter _________

How did you hear about the Club?

Class ______    Club member _______   Newspaper _______  Newsletter _________

MEMBERSHIP IS 
FREE!!

E-waste Recycling Center
North Bay Self Storage is located at 720 Southpoint Blvd. in Petaluma 
on the same street as the Department of Motor Vehicles.  

We are a Bay Area Green Business and a 100% solar powered office 
building and storage facility.

Recently, we became a Green Spot Drop Off location.  You can bring 
your e-waste i.e. computers, monitors, printers, print cartridges, cell 
phones etc. for recycling.  You can drop items off during regular 
business hours, 7 days a week.  

Call for more info at 707-766-9900.

We make no money from this service but our partner Coastal Recycling donates $1 for each recycled item to 
the Petaluma Educational Foundation.
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for Mac Users

• MAC USER GROUP MEETING

Date:  Saturday, December 10
Place: at Maria’s

Time:  9 a.m.

Topic: iPhoto Editing

Where to Recycle Used 
Computer Equipment

http://www.crc.org/

Check out iRecycle!
http://earth911.com/iphone/
iRecycle makes it easy to find 
recycling locations anywhere in 
the U.S

Newsletter made with Pages on an iMac

All meetings are FREE.
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